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Welcome
Welcome From
From The
The Chief
Chief Editor
Editor
In a lot of ways, it's difficult to imagine that 2010 is
already over. It just didn't seem to last long, at all. 2010
was a busy year for PCLinuxOS. We saw the arrival of
KDE 4 as the default desktop for PCLinuxOS. The move
to KDE 4 was welcomed by many, and lamented by
others. We also saw the number of alternate desktop
environments increase to include not only Gnome, Xfce
and LXDE, but also Openbox, e17, and even Wmii. Of
those, most were offered up in both "full versions" and
"mini versions." We even saw the introduction of "KDE
Full Monty," which has most anything and everything a
user might want to install, via a Live DVD. Now, there is
literally a desktop for every user, running most any kind
of hardware, new or old.
Typically, the coming of the New Year's holiday signifies
a time to ring in changes. For The PCLinuxOS
Magazine, it means a small name and logo change.
After 18 months, we are no longer "NEW." So, in
keeping with the spirit of the New Year's holiday, we are dropping the
"NEW" from the name of the magazine. Nothing else changes. I, along
with the rest of the staff, remain dedicated to bringing you the magazine
on a monthly basis, packed with the informative and entertaining articles
that you have come to expect. The new logo for the magazine was
designed by Timeth, and will now grace the cover of our monthly
magazine.
This month, we continue our look at the e17 desktop. Meemaw begins a
three part look at the e17 System Panel settings, while I take a look at
e17 Modules and the use of gadgets on the e17 desktop. Pete Kelly
returns with an indepth look at Grub, with some tips on how to fix it

when it seems to get a mind of its own. Meemaw also
takes a look at another of the Ladies Of PCLinuxOS,
with her interview of JRex.
I take a look at using and setting up Radio Tray, in the
Repo Spotlight column this month. Leiche shows us how
to add some useful eye candy to our PCLinuxOS
desktop, exploring how to set up and use Wbar, which
will give users a Mac OSX like quick launch bar.
Meemaw kicks off another multipart article series that
will cover using Scribus to create a newsletter. This topic
is dear to us who work on the magazine layout every
month, since we use Scribus to lay out the PDF version
of the magazine. There's nothing quite like covering a
topic that you know intimately!
Gary Ratliff, Sr. returns with another installment in his
Computer Languages From A To Z column, with a look at
Unicon. Darrel Johnston finishes up his look at Kolibri, in his Alternate
OS article series. Of course, ms_meme graces us with two installments
of Forum Foibles this month, along with two installments of ms_meme's
Nook. Mark Szorady's Double Take & Mark's Quick Gimp Tip is back for
another of his dose of his monthly column and cartoon. We also have a
couple of testimonials, culled from the PCLinuxOS Forum.
As the New Year arrives, I'd like to wish each and every person out there
the most prosperous and healthy New Year. Until next month, I'd also like
to wish each and every one of you peace, prosperity, happiness, serenity
and tranquility.
Paul Arnote, Chief Editor
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Using
Using Scribus,
Scribus, Part
Part 1:
1: Getting
Getting Acquainted
Acquainted
by Meemaw

From left to right, we have New, Open, Save, Close,
Preflight Verifier, Convert to PDF, Undo, Redo, Cut,
Copy, Paste, Selection, Create Text Frame, Create
Image Frame, Create Render Frame, Create Table,
Insert Shape, Insert Polygon, Insert Line, Insert
Bezier Curve, Insert Freehand Line, Rotate Item,
Zoom In or Out, Edit Contents of Frame, Edit Text,
Link Text Frames, Unlink Text Frames,
Measurements, Copy Item Properties and Eye
Dropper. Insert Shape and Insert Polygon each have
drop down menus so you can designate the type of
object you want to insert.

"I'm doing a newsletter at work, and I need a
desktop publishing application. I used to use
(Windows or Mac) Program X, but now that I've
changed to Linux, I need to know what's available."
Sound familiar? Never fear, we have the right
program for you: Scribus. From their website:
Scribus is an Open Source program that brings
awardwinning professional page layout to
Linux/UNIX, Mac OS X, OS/2 Warp 4/eComStation
and Windows desktops with a combination of "press
ready" output and new approaches to page layout.
Underneath the modern and user friendly interface,
Scribus supports professional publishing features,
such as CMYK color, separations, Spot Colors, ICC
color management and versatile PDF creation.
Why would you want to use Scribus? Scribus is
powerful software that helps you create great
looking documents of all kinds.
Oh, by the way, this magazine is made using
Scribus! The current stable version in the repos is
Ver. 1.3.8
Let's get started.
The startup screen will be the first thing you see.
The first thing you want to do is to edit your page
properties. Your page properties will be for this
project only. The default settings are shown above.
You have the choice of single
page, doublesided, 3fold or
4fold. You can also put in
many other configuration items

such as your margins, paper size, portrait or
landscape orientation and even if you need more
than one page. If you aren't sure how many pages
you need, don't worry as you can add pages later.
You can also designate the unit of measure you wish
to use. We do the magazine using points, but you
can change it to inches, centimeters, or other units
you wish to use (I use inches at work). For our
example, I am keeping the defaults, except to
change the paper size to Letter. If you change your
mind about margins afterward you can go to File >
Document Setup and make your changes.
When you open your document, the default toolbar
should look as shown below.

The two extra windows open at right are Document
Properties and Layers. I have these open all the
time because most of the design is done using these
windows. If you mess up
and close one, you can
always go to the menu bar
and click on Windows. You
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will see a whole list of windows you can use; just
click on the one you want. We'll use a few more of
these soon. Also, at the bottom of your main window
you will see a few other handy things... zoom, page
navigation, level navigation and preview mode
(looks like an open eye).
Items are added to your document by the use of
frames. If you want text, add a text frame. If you
want to place a picture, add an image frame and put
the picture in it. Let's start by adding a text frame.
From your toolbar, click on the Create Text Frame
button (it looks like a piece of paper with a big A in
the corner). Then click and drag to make a rectangle
on your page.
Don't worry if it isn't the right size or in the right spot,
but notice that the text in the Properties window that
was grayed out before is now suddenly 'active' and
the boxes are filled with numbers. The Properties

window is where you can configure each item you
put into your document. Using this window you can
not only make your items the right size, but also
place them exactly where you want them, which is
much easier than trying to place it with the mouse.
I want my text box edges to be exactly on my top
and left margins, so I will set the XPos and YPos
both at 40 pt – right where I set my margins. In many
newsletters, the size of the text box will generally
depend on the length of the article, so I will leave the
height and width alone for now.

into this window. When you click on the green check
mark in the top row, the window will close and your
text will be in the text frame. All of your text frames
will be filled in this manner.
You can add graphics too. Click the Create Image
Frame button and click and drag, just like you made
your text frame.

On your toolbar, you saw a button that looked like a
notepad with a pencil on it toward the right end. With
your text box selected as in the above picture, click
on the notepad  that is the Story Editor tool, and
will give you the window shown below (or right click
inside the text frame and choose Edit Text from the
context menu):

To insert the image, rightclick
somewhere in the frame and
choose Get Image>

This is the Story Editor window. You can use it to
write your article or, if you have a text document that
you want to use, you can copy and paste the text

When it is inserted, you can
configure it. You can right click
on the image and choose Fit
Image to Frame. That choice
will shrink your image down to
fit within the frame you have
drawn, but it may not fit
precisely. If you know what size
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your image needs to be you can enter those
numbers into the dimensions in the Properties
window. You can also choose Fit Frame to Image,
which changes the frame so it is exactly the same
size as the image.

helpful when you have several frames and some
need text wrapped around them. If you lock the
frame, it won't move accidentally and you can go on
and work with something else.
Shape is for text wrap. After you put in a picture and
get it placed correctly, you can set the shape so the
text wraps around the picture and can all be seen.

Colors  Here you configure the color of any object
you insert (although text color is configured in the
Text tab). If you insert a rectangle for decoration, you
can choose the border and fill color and also the
transparency. Horizontal and vertical gradients can
be configured as well.
We can start our newsletter next month.

Group  Group is used to set text flow around a
group of objects (rather than Shape for an image).
Some of the things you use may be
shapes that have been grouped
together, and this is supposed to
configure the text flow. However, it
doesn't work correctly quite yet in the
more recent versions of Scribus, so in
later articles, we'll look at ways to
accomplish that another way.
Configure Image

Let's look at the Properties window again.
Everything can be configured using this
window. The sections in the window are
X,Y,Z, Shape, Group, Text, Image, Line
and Colors.
X,Y,Z is the one you see and use most
often. It is the one you use for size and
placement of your frame. You can raise or
lower your frame from the arrows under
'Level' (which helps if you have two pictures
that overlap.) Notice also the button at right
that looks like a lock: it is used for 'locking'
an item in a certain spot. This is particularly

Text is where you will configure your
text. Font and size are configured
here, as well as color and text effects.
If you want a big title with blue text
outlined in red, you can do that here.
There are text configuration items in
the text editing window that you can
use, but you really should do most of
it from the Text tab in Properties. We'll
explore that in a later article as well.
Line  If you want your text or image
frame to have a border, you can
configure it here. You are given many
line styles and sizes. Before you can
see it, however, you must go to
Colors and choose a color, as the
default is none.

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.
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e17:
e17: A
A Look
Look At
At Modules
Modules
by Paul Arnote (parnote)
One of the huge attractions of e17 is its modular
construction. With the addition or subtraction of a
variety of modules, e17 can be as lean as possible,
or it can be as full featured as the "big daddy"
desktops KDE and Gnome. Also, you will find that
modules and gadgets are somewhat closely tied
together. Loosely translated, this means that before
you can make use of a particular gadget, you must
first activate the module that controls the gadget's
function.
By going to the PC menu, you can bring up the
Modules dialog box. Simply go to Settings »
Modules. It should look something like this:

In total, there are 133 modules, divided into eight
different sections. Here is a list of those sections,
with the modules available under each section, and
the default description of each module (if available):

UTILITIES

IBox: A home for your iconified applications.
ITask: It will hold all of your open applications for
fast switching.
Iiirk: Act like a taskbar but only for selected
applications.

Alarm: A module which allows you to set popup
reminders.

Language: Gadget to control active keyboard,
keyboard layout, and layout variants.

Calendar: Calendar sheet showing the current day.

MPDule: View what's playing in MPD.

Clock: Nice clock gadget to show current time.

Mail: Mail notification gadget. Checks POP3, IMAP,
maildir and mbox mailboxes.

Deskshow: Gadget to allow you to quickly uncover
your desktop.
DiskIO: Visualize disk i/o.
Drawer: A gadget that acts as a container for data.
EMpris: Control MPRIS supporting music player like
Amarok, Audacious, xmms, VLC and others.
EWeather: A weather gadget.
Execwatch: Shows the last state of a periodic
executed cmd. Useful as an update checker or for
checking if a remote host is available (through ping).
Forecasts: The forecasts gadget will display the
current weather conditions plus a few days forecast.

Moon: Gadget for e17 which displays the current
phase of the moon.
News: Gadget to monitor RSS feeds.
OpenOffice.org Quickstart: This module preloads
the openoffice process to save start time with the
costs of some memory.
Pager: Gadget to allow you to visualize your virtual
desktops and the windows they contain.
Photo: View photos or a mini slideshow within this
gadget.
Screenshot: Gadget to take screenshots using
emprint.

IBar: Iconic application launcher.
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Slideshow: Turns your desktop background into a
slideshow.

Cpufreq: Gadget to monitor and change the CPU
frequency.

Penguins: Module to display fancy penguins
walking around your desktop.

Start: e17's "Start" button equivalent.

DBus Extension:

Rain: Module to display rain on the desktop.

Systray: System tray that holds application icons
like Skype, Pidgin, Kopete and others.

Ecomorph: Ecomorph module.

Snow: Module to display snow on the desktop.

TClock: A digital clock gadget.

Itask NG: A dock that holds a taskbar and
application launcher.

Taskbar: Gadget to provide a taskbar.

Mem: Used to monitor memory utilization.

FILES

Uptime: Gadget to display the current uptime of the
system.

Mixer: A module to provide a mixer for changing
volume.

Weather: A weather gadget.

Mobile Modems Manager: Control mobile modems.

Winselector: This gadget provides a menubased
access to all the windows.

Net: Network interface monitor.

EFM Operation Info: Can be placed on the desktop
or on a shelf.

Places: This module manages the volume devices
attached to the system.

EFM Path: A module that allows a user to type a
location into the file manager.

Temperature: Temperature monitor.

EFM Pathbar: A module that provides a pathbar
gadget to navigate the filemanager module.

Wlan: Gadget to monitor a wlan device.

SYSTEM
Battery: A gadget to visualize your battery status.

LOOK

Bluetooth Manager: A gadget to manage your
Bluetooth connection and devices.

Composite:

Connection Manager: Control Wifi and wired
networks as a user.
CPU: Used to monitor CPU utilization.

Dropshadow: Module to add a dropshadow to
windows.
Flame: A module to display flames on the desktop.

EFM (Starter): e17's integrated file manager (under
construction)
EFM Navigation: A module that allows a user to
navigate the filemanager module.

LAUNCHER
Everything (Starter): The run command module
provides an application launcher dialog.
Everything Applications:
Everything Aspell: Aspell frontend. Use "aspell" as
trigger.
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CORE

IllumeHomeToggle:

Everything Files:

Gadgets: Module to manage gadgets on the
desktop.

IllumeIndicator:

Everything MPRIS: Control MPRIS compatible
media players from Everything.

Notification: libnotify alternative. Popup if an event
occurs.

Everything Pidgin: Open chat windows and send
files to buddies.

Settings Panel:

IllumeModeToggle:

Everything Places: Access folder bookmarks and
mount drives.

System Controls: This module provides a unified
popup dialog for all the system actions in
Enlightenment.

IllumeSoftkey:

Everything Settings: Quickly open e17 settings
dialogs.

Tiling: Positions/resizes your windows tilingly, like
ion for example.

Everything Tracker: Find files with Tracker
(requires version 0.8).

Window Switcher List: A module

Everything Wallpaper: Select wallpaper or create
new ones from images.

Winlist NG:

Everything Calculator: Frontend for bc. Use "=" as
trigger.

Everything WebSearch: Find stuff on Wikipedia,
use Google suggestions and 'Google for it' (tm)
action.
Everything Windows: Window actions.
Quick Access: Provides quick access to chosen
applications.
Run Command: The run command module
provides an application launcher dialog.

to show the
list of client applications presently running.

MOBILE
Illume: This is a module to make Enlightenment
tuned for embedded touchscreen displays such as
on phones and webpads with windows always
being fullscreen and having a simplified application
launcher and manager.
IllumeBluetooth:
IllumeHome:

IllumeKeyboard:
IllumeKeyboardToggle:

Illume2:

SETTINGS
ACPI Bindings: Configure your ACPI bindings here.
Applications: Allows configuration of IBar, Restart,
and Startup Applications.
Borders: Used to select a default border style.
Client List Menu: Allows customization of the client
list menu.
Colors: Used to customize the color classes.
Desk: Used to configure the desktop names and
wallpaper for individual virtual desktops.
Dialogs: Configure default dialog properties.
Edge Bindings: Configure your edge bindings here.
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Engine: Used to select the rendering engine.
File Icons: Configure e17 mime icons.
Fonts: Font configuration dialog.
Icon Theme: Settings applet used to select an icon
theme for e17.
Input Methods: Used to select an input method.
Interaction: Configure default user interaction
settings.
Key Bindings: Configure your keybindings here.
Language: Used to select a default language.
Menu Settings: Configures menu behavior.
Mouse Bindings: Used to configure your mouse
bindings.
Mouse Cursor: Select the mouse cursor style.
Mouse Settings: Configure mouse behavior.

Scaling: Used to configure how display scaling is
handled.
Screen Lock: Configures the integrated desk lock.
Screen Resolution: Used to configure your
screen's resolution.
Screen Saver: Configures the X screensaver.
Search Directories: Specifies the e17 search paths
and default directories.
Shelves: Shelf configuration dialog.
Startup: Used to configure the e17 splash screen.
Theme: Used to configure your theme preferences.
Transitions: Used to choose a default transition.
Transitions are used upon wallpaper changes,
among other things.

Window List: Configure your window list properties.
Window Manipulation: Configures window raise,
resistance, and maximize policies.
Window Remembers: Delete existing window
remembers.
That's all 133 e17 modules listed above. It's
important to remind you that the modules have to be
selected in order to use the gadgets that are
associated with the module.
Many of the modules are fairly self explanatory,
based either on their name or on their description. In
all fairness, we'll take a closer look at what some of
the more popular modules do when we take a look
at the gadgets that are associated with the modules
in a separate article.

Virtual Desktops: Configure the virtual desktop
properties.

Performance: Used to configure certain
performance related items, such as frame rates and
cache settings.

Wallpaper: Used to pick a wallpaper.

Power Management: Configure the DPMS settings
of your system.

Window Display: Configures default window
properties such as default geometries, border icons,
placement styles, etc.

Profiles: Allows management of configuration
profiles.

Window Focus: Configure window focus behavior.

Wallpaper 2: Used to pick a wallpaper.

Your Community Projects Forum
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International Community
PCLinuxOS Sites

Screenshot
Screenshot Showcase
Showcase

Netherlands

Turkey
Denmark

Czechoslovakia

Italy

Poland

Posted by Dragynn, December 1, 2010, running Zen Mini
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Forum
Forum Foibles:
Foibles: Happy
Happy New
New Year!
Year!

Happy New Year Texstar
PCLinuxOS has come of age
You've traveled oh so far
Now it is all the rage
Happy New Year Forum Friends
We are PCLinuxOS folks
Thanks for help that never ends
And for all those Sandbox jokes
We boot up and give a cheer
PCLinuxOS we loudly proclaim
We'll be here next year
And do more of the same
Happy New Year Texstar
We know you've made the best
PCLinuxOS is way over par
It beats out all the rest
ms_meme
Re: Forum Foibles
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Mark's Quick Gimp Tip

©2011 Mark Szorady. Distributed by georgetoon.com

by Mark Szorady

Double Take

Double
Double Take
Take &
& Mark's
Mark's Quick
Quick Gimp
Gimp Tip
Tip

Find at least seven differences between cartoons.

As I’ve mentioned before, I use Gimp to
enhance photos. And Gimp does a nice
job of adding certain “special effects” to
photos. Have you ever seen a film or
commercial where everything is in black
and white but one element is in color?
That color element really stands out. Well,
you can achieve this effect in The Gimp
quite easily. Step one, open a color
photograph. Duplicate it by selecting
Image>Duplicate. A new image appears in
it's own window. In the new image, select

Image>Mode>Grayscale. This
changes the photo to black
and white. Now, copy the
photo by selecting Edit>Copy.
Select the color photo. Paste
the B&W image into the color photo as a
new layer by selecting Edit>Paste As> New
Layer. A new layer of the B&W photo will
drop on top of the color photo perfectly
aligned. Now, working on the B&W layer,
simply grab your eraser tool and remove
any gray area where you want color to
show through. And, TaDaa! A B&W photo
with color added in specific areas! You can

Answers on Page 21

see the effect in the photo of my old red
car. I erased the gray hood area to allow
the red in the color photo to show through.

Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.
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Alternate
Alternate OS:
OS: Kolibri,
Kolibri, Part
Part 2
2
by Darrel Johnston (djohnston)
The instructions for using GRUB to boot KolibriOS
on Kolibri’s wiki at
http://wiki.kolibrios.org/wiki/Main_Page indicate that
“there is one limitation in this method: The kernel
cannot save its boot settings.” As I previously stated,
I found that not to be the case. Once Kolibri is
booted from the hard drive, select Menu > System >
Work with files > Save RD image, as shown below.

Saving to /hd0/1/kolibri.img will restore your settings
on the next bootup (center top.)
The applications shown in this article are not all of
the applications included in the distribution. There
are more in the main menu, and there are even
more included in the Live CD.

Beginning with the desktop icons in the upper left
corner (bottom center), we have the flat assembler
window open. FASM is the assembler used to create
almost everything in this OS. Tinypad is the editor
used for coding and general text files. RDsave is for
saving the contents of RAM to a drive. EOLite (not
shown) is another file browser. Calc is a calculator
with scientific functions. KFM is the Kolibri File
Manager. The last two desktop icons in the group
are Shell and KFAR, which is a Commander type file
manager.

The lower left hand corner of the desktop shows a
group of six games (next page.) I could not get
PARA (a Pharoah’s Tomb Game) or LODERUN to
launch. I could not find the executables in Kolibri’s
Games directory, either. Shown are Pipes, Arcanoid,
Xonix and Kosilka, which is described as a grass
mowing game.
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DOCPACK is a
group of links to
included
documents.

The next two screens
show some of the 3D
demonstations
available (next page.)
The file manager is
open because I
launched each
executable program
from the file manager.
The gears program is
functionally the same
as GLGears. It does
display the framerate,
but it is displayed in
the window’s title bar
and is hard to see.

The icon group in
the lower right
hand corner of the
desktop are all
games. Shown
are Checkers, 15,
which is a puzzle
game, Life, Tetris
and C4, another
puzzle game
(right.)

The icons in the upper
right hand corner of the
screen are utilities (right.)
MTDBG is Kolibri’s
program debugger.
BOARD is a kernel
message debugging
board. VRR is to change
the vertical refresh rate of
your monitor. The option
is also available on
Kolibri’s boot screen.
ANIMAGE is an animated
image editor. I haven’t
been able to determine
what graphics file format
the program works with.

The last three
games are
Pong, HBlocks
and
Minesweeper
(right.)
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In the top row (bottom left) are the file manager,
BCD clock, analog clock, pacman logo and a hex
editor. In the bottom row are a color reference,
color slider, more 3D demonstrations and an
elapsed time indicator.

HTML and HTTP Viewer.

HTTPC is listed in the menu as a simple HTTP
client. Shown above are the results of loading
http://google.com. Another web browser included,
HTML and HTTP Viewer, continually crashed as
soon as I loaded any web site. I believe it is
intended to be a local HTML viewer.
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Shown on the previous page is a font demonstration,
a calendar and a screenshot program.
Shown below are some of the programming tools
and examples.

Kolibri is not for the average user, as most people
would demand to have a functional web browser.
However, the operating system is a very good
example of what can be done by coding almost
entirely in assembly language. I am amazed at the
number of programs included in what fits on a single
floppy disk. I have not shown all the programs
included. If your computer has a floppy drive, you
can try out this amazing OS by downloading the
image file, transferring it to a floppy and booting from
it. If you want the full experience, download, burn
and boot the live CD.

Screenshot
Screenshot Showcase
Showcase

Posted by T6, December 18, 2010, running KDE 4
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Ladies
Ladies of
of PCLinuxOS:
PCLinuxOS: JRex
JRex
Note: This month's PCLinuxOS Lady is a
relative newcomer to the forum, having just
registered on September 28, 2010.

that your being a woman has an
impact on your treatment by the rest of
the community? If so, in what way?

Can you start off by introducing
yourself, and telling us a little bit about
yourself? (Real name, where you live,
marital status, children/grandchildren,
hobbies/interests, etc).

IT in itself is a predominantly male area.
I've been working in IT for a long time,
over 10 years. I learned early on that in
order to survive, I had to be able to roll
with the punches, joke around, and most
of all, apply logic to work through a
situation. By doing that, I've been able to
gain the respect of my male counterparts.
The fact that I'm a woman doesn't factor
in much as a result (except in making the
guys jealous of Rudge for having a geek
for a wife).

I'm Jennifer Galloway, and I live in
Huntersville, NC. I am happily married to
Rudge. We have no children, unless you
count our two dogs, Molly and Shinjo. I'm
very active in my church (chancel choir,
hand bell choir, and I'm currently serving
on the board of Deacons). My hobbies
include watching movies with Rudge,
reading, listening to music, and making
jewelry.

Do you feel that your use of Linux
influences the reactions you receive
from your computer peers or family? If
so, how?

How did you get started in computers?
Back in 1993, I was the one person in my office who
wasn't afraid of computers. Because of that, I got to
be the person who installed software on the office
desktops, and did troubleshooting for anyone who
had problems with applications or connectivity.
What drew you to Linux?
I like the fact that Linux is communitybased. Distros
exist because of the power of the group, and they
improve because of it.

What was the first Linux distro that you used?
SuSE (I don't remember what version, sorry).
When did you first start using PCLinuxOS? What
attracted you?
Rudge is the one who introduced me to PCLinuxOS.
He fell in love with it because of the community and
the design (he loves the rolling distro).

It gives me a different perspective to
approaching common problems. In
general, I've found that those who aren't familiar with
Linux just don't get what I'm talking about, and those
who do are Linux or Mac users themselves.
How do you feel you contribute to the
PCLinuxOS community?
Being that I spend basically all of my time in the
Sandbox, I think I contribute a quirky sense of
humor.

With Linux having a reputation of being a realm
predominately populated by males, do you feel
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e17:
e17: Gadgets
Gadgets Galore
Galore
by Paul Arnote (parnote)
Once you have the modules installed, you can then
place a wide variety of gadgets on your e17 desktop.
Its the gadgets that really put the icing on e17 users'
desktops, and you can do so without suffering much
of a memory hit. In fact, much of what you see on
the e17 desktop is a gadget, or a collection of
gadgets. Even the panel is a collection of gadgets,
placed onto a shelf. Just remember that if you don't
see the gadget listed that you want to use, it's most
likely because you don't yet have the module
installed/activated that controls the gadget.

Your list of gadgets may differ somewhat from that
shown above, based on the modules you have
installed.

Another popular gadget for the e17 desktop is the
"Places" gadget. It allows you to see the status of
your mounted drives at a quick glance.

So, let's take a look at a few of the more popular
gadgets that you can add to your desktop.

Wlan

Clock

By selecting the PC Menu, go to Settings > Gadgets.
You will see a window similar to the one below:
The analog clock does seem to be one of the more
popular gadgets for the e17 desktop, and rightfully
so. It's very well done and looks quite distinguished
on the desktop. The clock gadget is listed simply as
"Clock" in the gadget list.
Places

If you use e17 on your notebook computer and
connect to the internet via a wireless wifi connection,
you might want to place the Wlan monitoring gadget
on your desktop. You can get immediate visual
feedback on the quality and strength level of your
wifi connection.
Screenshot

The screenshot gadget in e17 allows you to take
screen shots of either your entire desktop, the active
window, or a region of your desktop, depending on
how you have it set up. You set the screenshot
gadget up by right clicking on the icon, and selecting
"Capture Mode" from the menu that pops up. Left
clicking on the screenshot gadget starts a
countdown (if you have a delay set up) before either
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taking the screenshot, or changing the cursor to "+"
to allow you to select the window to capture.
Digital Clock & Battery

At the far right side of my panel are the battery and
digital clock gadgets. The battery gadget allows me
to monitor the current state of my laptop's battery
(charging or discharging), as well as how long it will
take to complete the charge, or how much time is left
before my battery's charge is depleted.
The digital clock is fairly self explanatory, and can be
found in the list of available gadgets as "TClock."
Systray, Pager & Mixer

Working right to left along the panel, we come to the
Systray gadget, where your system notifications
occur. Next, is the Pager gadget, which gives you a
graphical representation of your virtual desktops.
Then is the Mixer gadget, which gives you access to
the various functions of your sound card, along with
the ability to control the volume of your sound card.

Taskbar

Even the taskbar is a gadget in e17, listed in the list
of gadgets as "Taskbar."
Ibar, Deskshow & Start Menu

At the far left side of the panel are three more
gadgets. Going from right to left, is the Ibar gadget,
which allows you to set up a quick launch bar of
applications of your choosing. Next is the Deskshow
gadget. When you click on it, all the open windows
are minimized so you can see the desktop. Finally,
at the far left, is the Start gadget, which provides the
more traditional "start menu" that you find on other
desktop environments.
Cpufreq, Temperature & Ibar

temperature of my CPU whenever I hover my mouse
pointer over it.
The bottom twothirds of the vertical shelf is taken up
by a second instance of the Ibar gadget. This
instance serves as a quick launch bar for other
applications I frequently use. From the top and going
downward, the applications are Gimp, DeaDBeeF,
File Roller, Gcalctool and Leafpad. For more
information on how to properly set up a second
instance of Ibar on your e17 desktop, see the e17:
Beginner Desktop Tweaks article in the December
2010 issue of The PCLinuxOS Magazine.
Conclusion
As you can see, virtually everything on the e17
desktop is made up of a collection of gadgets. How
you arrange those gadgets is clearly up to you, and
the possibilities are as endless as the number of
people using e17. It makes it very easy to create a
desktop experience that is not only tailored to you
and your needs, but also one that is unique and
unlike the next e17 user's desktop.

On my installation of e17, I've set up another
shelf on the desktop to hold some other
gadgets that I find useful. At the top of the
vertical shelf is the Cpufreq gadget. With on
demand CPU scaling, this little gadget lets
me know to what clock speed my CPU is
currently running at. Below that is the
Temperature gadget, which informs me of the
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Answers to Mark Szorady's Double Take:
(1) Hand changed to mitten
(2) Word balloon different
(3) Hair shorter
(4) Snowman eye moved
(5) Snowfall missing
(6) Hat tassel different
(7) Scarf stripes different

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...

Screenshot
Screenshot Showcase
Showcase

Posted by Crow, December 28, 2010, running LXDE
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Grub:
Grub: Fixing
Fixing The
The Boot
Boot Loader
Loader
by Pete Kelly (critter)
It's getting late and tomorrow you have a busy day.
So you save your work and shut down your
computer. The following day, you power up your
computer and your heart sinks when you see the
message "kernel panic..." or "grub error xx" and your
machine will not start.
What to do? Well the good news is that the fact that
you got one of those messages suggests that it is no
more than a software problem, and you may just
need to fix up a configuration file or reinstall the
boot loading program. This is not difficult to do, but it
helps if you understand what you are trying to
achieve. So first of all, we need a little background
information. I'll try to keep this simple.

The boot process
When you apply power
to a computer, the
processor needs to be
told what to do. The
motherboard stores a
list of drives that the
computer can boot
from, and knows the
order in which these
should be tried, and so
points the processor to
the first drive on the list. The processor goes to the
very beginning of the storage area of the drive to

look for more information. This storage area is
divided up into smaller areas, known as sectors, and
the processor looks at the first sector on the drive,
which is known as the Master Boot Record or MBR.
The first sector of any other partition is also
reserved, and is known as the boot sector. There
isn't sufficient space in here to store all of the
information the processor needs, so it shows the
processor where to find the code that will complete
the rest of the boot loading process, so that the
processor can continue to a full system boot.
The boot loading program used by PCLinuxOS is
called grub (GRand Unified Bootloader), and the
code stored in the MBR is known as 'grub stage1.'
The final bit of code loaded into memory is 'grub
stage2.'
Stage 2 starts the kernel and will set up a temporary
file system in memory, which contains things like
modules and drivers that the kernel may need to
complete a successful system boot. It does this
using a file system image known as the 'initial ram
disk,' or initrd.img.
Unfortunately, we have a problem here. On the one
hand we have stage2, which knows where the
kernel and initrd are stored on the file system, but
stage1 knows nothing about file systems. Enter
stage1_5. There are several of these and each one
is file system specific having names such as
e2fs_stage1_5 and reiserfs_stage1_5. The stage1_5
code in these files is the bridge between the two, but
needs to be able to be found by stage1. Fortunately,
due to the way that partitions are laid out on a drive,
there are always some free sectors after the first
reserved sector, and this is where the extra code

goes. Stage1 knows to always look in the second
sector of its root partition, and after executing the
code there, grub will be able to find things in the file
system.
When sufficient work has been done setting things
up so that the kernel can manage physical files
systems, control is handed to the kernel.
That's roughly how things work in PCLinuxOS, but
there is a whole lot more to the grub system than
described here, and this is not the only way to boot
the system.

Recovery
What follows is applicable to PCLinuxOS
distributions and has always worked for me, but may
need some modification for other systems. Ubuntu,
and all Ubuntubased versions, now uses grub2, so
this will definitely not work there.
From the above, we can see that grub needs to be
told three things that it needs to boot your operating
system:
• Where is the kernel
• Where is the initrd
• Which drive or partition holds grubs stage1_5 and
stage2
This information is most commonly passed to grub in
its configuration file, which in PCLinuxOS is
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/boot/grub/menu.lst. Some systems call this file
grub.conf. If the information passed in this file is
incorrect, then a missing kernel or initrd will give a
grub error, and a wrongly defined root file system will
cause the kernel to panic.
The information can also be supplied on the
command line at boot time, although this requires a
little more effort to master.
To repair the system, you can boot from the Live CD
that you used to install PCLinuxOS. This will get an
operating system running in memory, and then you
can repair any damaged files on your hard drive.

su <enter>
You will be prompted for a password. This is the
administrative or root password, and not your own
user password. Please remember that now you have
administration rights you should be extra careful
about what you enter on the command line.
Type
grub <enter>
You will get a message about probing, and then you
will enter the grub command shell, where you can
enter commands and even reinstall the resident part
of grub:
GNU GRUB version 0.97 (640K lower /
3072K upper memory)
[ Minimal BASHlike line editing is
supported. For the first word, TAB
lists possible command completions.
Anywhere else TAB lists the possible
completions of a device/filename. ]
grub>

Finding the information
The first thing you need to know is the drive and
partition on which PCLinuxOS is installed, and grub
can help here. After booting from a Live CD, open up
a terminal and get administrative powers by typing:

At the new prompt, enter the following:
find /boot/grub/stage2 <enter>
You will get a list of partitions that contain the grub
stage2 file. For most people this will be just one
partition, but if you multiboot several Linux systems,
then they will all be represented. All the partitions will

be listed as (hd0,0) or similar, as grub doesn't
understand hda1 or sda1. It sees them only as
drives. Grub counts starting at zero, not one. The
first number is the drive number, and the second
number the partition number. Type quit <enter>
to leave grub.
Now we know the drive and partition that our
operating system is installed on, we can mount it
and have a look around. I'm going to assume now
that the partition is (hd0,0), the first partition on the
first drive. In the terminal, still as root, type:
mkdir /a <enter>
mount /dev/sda1 /a <enter>
You will have to change sda to hda if your drive is
IDE. If you don't know, try typing fdisk l
<enter> to get a list of recognized drives.
The drive is now mounted at /a, and so the kernel
and initrd should be in /a/boot. The name of the
kernel and the initrd are quite long and complex, so
there are usually easy to type links (shortcuts) to
refer to them. The kernels name begins with vmlinuz
and initrds name begins with initrd. To see them,
type the following and make a note of the names.
ls /a/boot/vmlinuz* <enter>
ls /a/boot/initrd* <enter>
The name that ends in an '@' is the link, and you
can use this in your grub configuration file.
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Labeling the partitions
I now have two links named vmlinuz and initrd.img. I
also know that the root device is (hd0,0), but I find
using labels makes life easier. So, typing tune2fs
L kde4 /dev/sda1 gives my partition a label of
kde4. I label all of my partitions in this manner. If you
prefer, you can use the graphical PCLinuxOS
Control Center, by going to Local disks > Manage
disk partitions > Expert Mode to label your partitions.

The configuration file
Now I can try and fix up the menu.lst file. I'll use
nano, a command line text editor that is really easy
to use to edit the file, but you can use any text editor
you like that can save a file as pure text with no
formatting. Open the menu.lst file from your installed
system:
nano /a/boot/grub/menu.lst <enter>
The original file looks like this:
timeout 10
color white/blue yellow/blue
gfxmenu (hd0,0)/boot/gfxmenu
default 0
title linux
kernel (hd0,0)/boot/vmlinuz
BOOT_IMAGE=linux root=UUID=442bec9e
f1434cc2866cd65a92fbac69

resume=UUID=afccaaaa054d424b8a3c
093f1b2a743d splash=silent vga=788
initrd (hd0,0)/boot/initrd.img
title linuxnonfb
kernel (hd0,0)/boot/vmlinuz
BOOT_IMAGE=linuxnonfb
root=UUID=442bec9ef1434cc2866c
d65a92fbac69 resume=UUID=afccaaaa
054d424b8a3c093f1b2a743d
initrd (hd0,0)/boot/initrd.img
title failsafe
kernel (hd0,0)/boot/vmlinuz
BOOT_IMAGE=failsafe
root=UUID=442bec9ef1434cc2866c
d65a92fbac69 failsafe
initrd (hd0,0)/boot/initrd.img
It really isn't as complicated as it looks. The first four
lines set up the menu, and each block of three lines
is an entry in the menu, known as a stanza. Each of
the above stanzas contains only three lines,
although the magazine typesetting will probably
break these up. The formatting in the menu.lst file is
important.
The three lines begin with 'title', 'kernel' and 'initrd.'
Each should be exactly one line long, even though
the 'kernel' line often becomes a rather long line.
There can be additional lines in the stanza, but
these lines must each be on one line.

Adding a new menu entry
I'm going to add a new stanza (menu item) at the
beginning, i.e. between the line that reads 'default 0'
and the one that reads 'title linux:'
title kde4
kernel (hd0,0)/boot/mykernel
root=LABEL=kde4
initrd (hd0,0)/boot/myinitrd
Make sure that you leave a blank line before, and
after, each stanza or grub will not know where each
stanza starts or ends.
After typing that in, hold down the Control key and
press X, you will be prompted to save the file. Just
say yes.
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That should be enough to get you booted, although
you will want to pretty it up once you are satisfied.
You could, in fact, have just those three lines in
menu.lst.
I didn't attempt to repair the file. Rather, I wrote my
own set of instructions that I knew to be correct to
the grub configuration file, menu.lst, and in that way,
I am in control. I also left the original set of
instructions for grub intact. Later, when I am sure
that I have a bootable system, I can go back and
edit the file, but I still have the original file contents.

What it all means
The four lines at the beginning of the menu.lst file
perform the following functions.
Timeout=10 sets the length of time in seconds that
grub will wait before booting the default menu item
or, if none is defined, the first menu item. Pressing
any key before that time cancels the countdown.
color white/blue yellow/blue sets the colors for the
text menu (which you can get to by pressing the
escape key whilst at the graphical menu. There are
times when you may need to do this). The first pair
of numbers sets the foreground/background colors
for the bulk of the menu, and the second pair serve
to highlight the selected line.
gfxmenu (hd0,0)/boot/gfxmenu tells grub where to
find the graphical menu.

default 0 sets the default menu item to boot,
counting from 0.
To improve on the simple 'no frills' stanza we can
start adding things to the 'kernel' line.
Adding splash=silent vga=788 at the end of
this line will allow the installed plymouth graphics
theme to hide the scrolling text. The number 788 is
optimal for most users' displays.
If you intend to use hibernation to shut down your
machine, you will have to tell grub where to find the
data to resume the session. This is stored on your
swap partition, and for that reason, this partition
should be slightly larger than the installed memory if
hibernation is to succeed. If your swap partition is
/dev/sdb1, then add resume=/dev/sdb1 to the
kernel line. We can specify the partition in this
manner, as grub will understand file systems and
drive notation by the time it gets here.
A default installation of PCLinuxos supplies three
stanzas.
The first one will provide a full graphical boot to the
login screen.
The next one is named 'linuxnonfb,' or similar, and
allows booting without a graphical boot splash,
which allows you to see system messges as the
system boots. This is useful for troubleshooting. You
can pause the scrolling text with the Scroll Lock key
on your keyboard.
The last one, named 'failsafe,' will boot to a limited

shell in single user mode, where you can perform
some administrative tasks, such as file system
checks and root password recovery. When all is well,
typing init 5 should get you back up to the login
screen.
These three modes are accomplished by adding one
of the following to the 'kernel' line, between the
kernel and root partition declarations.
BOOT_IMAGE=linux
BOOT_IMAGE=linuxnonfb
BOOT_IMAGE=failsafe
When you know that your new menu item(s) boot
the system successfully, you can delete the old
ones, but make a backup of the file somewhere you
can always get to it. If you precede each line with a
'#' then that item will not appear on the menu. Any
line starting with a '#' is treated as a comment, and is
not executed.

Reinstalling the boot loader
If the grub set up itself has become corrupted, then it
is a relatively easy task to reset it. As before, open a
terminal, use the command su to get root privileges,
and start the grub command shell with the command
grub <enter>
Use grub's find command to discover which
partitions have grub's files on them.
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grub> find /boot/grub/stage2 <enter>
(hd0,0) < This is grubs output

That's it, we're done. Type quit <enter> to leave
grub.

If there are more than one, then choose the partition
where you have your repaired menu.lst file. Tell grub
about it by typing

Multibooting operating systems

grub> root (hd0,0) <enter>
Use the partition you chose here.
Filesystem type is ext2fs, partition
type 0x83
Now tell root where to put its stage one file. This is
the drive that your motherboard BIOS will try to boot
from. Note that no partition number is required, as
we are specifying a device.
grub> setup (hd0) <enter>
Checking if "/boot/grub/stage1"
exists... yes
Checking if "/boot/grub/stage2"
exists... yes
Checking if "/boot/grub/e2fs_stage1_5"
exists... yes
Running "embed
/boot/grub/e2fs_stage1_5 (hd0)"... 17
sectors are embedded.
succeeded
Running "install /boot/grub/stage1
(hd0) (hd0)1+17
p(hd0,0)/boot/grub/stage2
/boot/grub/menu.lst"... succeeded
Done.

If you want to be able to boot into one of several
distributions, then this is is most easily achieved in
this manner.
At the end of the installation process you are asked
where you would like to install grub, and the default
is the MBR of the drive you have installed to.
Instead, select the installation partition. You will then
be prompted for the drive to boot from. This is the
same as the root  setup sequence we performed
manually in grub at the terminal.
You will now have two menu.lst files, one in the
/boot/grub folder of the new installation and the
original one. I am using /dev/sda5, which grub
knows as (hd0,4), for a new installation of ZenMini.
Add the following lines to the original menu.lst.
title zenmini
root (hd0,4)
configfile /boot/grub/menu.lst
When I select this menu item, I will be taken to new
screen showing the menu items and the graphics of
the new installation. I can now have the menu.lst file
in the new installation identical to my default
menu.lst, with the only change being that every
occurrence of (hd0,0) becomes (hd0,4), which
makes system maintenance so much easier. A
stanza in the zen menu.lst might look like this:

title zen
kernel (hd0,4)/boot/mykernel
root=LABEL=kde4
initrd (hd0,4)/boot/myinitrd
Here's part of my default menu.lst:
title lxde
root (hd0,5)
configfile /boot/grub/menu.lst
title e17
root (hd0,6)
configfile /boot/grub/menu.lst
title Phoenix
root (hd0,7)
configfile /boot/grub/menu.lst
I find this much easier to follow.

Adding Windows to the menu
To boot an operating system such as Windows, that
doesn't use grub but has its own boot loader, you
can proceed in a similar manner. You have to add a
stanza to menu.lst like this:
title Windows
rootnoverify (hd0,2)
makeactive
chainloader +1
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Note: change (hd0,2) to the partition that windows is
installed on

which you may need to do if your editor has broken
the line and you have a half line of garbage.

rootnoverify works like the root command,
informing grub of the location of the next part of the
boot code, but no attempt is made at this stage to
mount the partition, as this could be problematic for
grub.

Press 'B' to attempt to boot with the modified lines.
The changes exist only in memory and are not made
to the menu.lst file. If this is the case, this should be
modified when you get a successful boot.

makeactive sets this root partition active
chainloader +1 tells grub to look in the second
sector of the partition for the boot code (the first
sector is always reserved by the file system).

Using the grub commands at boot time
If booting fails, then it is still possible to get to a
working system by using the grub command shell. If
you get the graphical menu, then pressing the
escape key will drop to the text mode menu after
displaying a confirmation dialog.
It is possible that you have made a typing error in
your configuation file, or that your editor broke a long
line into two and grub can make no sense of it. From
here, you can edit the line. Select the menu entry
that doesn't boot with the arrow keys and press 'E'
then enter. Pressing 'E' again will place the selected
line in the grub shell, where it may be edited. The
cursor will be at the end of the line, but you can
move with the arrow keys, as well as the home and
end keys. Press Enter to accept any changes, or the
escape key to return to the previous screen without
saving. Press 'D' on a highlighted line to delete it

If you can find no errors in the lines, then all is not
lost. Press 'C' to get a command line, and this puts
you in a similar same environment to that we used
from a terminal to reinstall the boot loader.
grub> find /boot/grub/stage2 <enter>
will locate partitions on all installed drives which are
candidates to become the grub root. Use the root
command to point grub at that partition.
grub> root (hd0,0) <enter>
To find the kernel on this partition, which should
reside in the /boot directory, we can use grub's
command completion feature. The kernel will be
named vmlinuz...something.
grub> kernel /boot/vm <tab>
Pressing the tab key here tells grub to fill in as much
as it can and list all possibiltes.
grub> kernel /boot/vmlinuz
Possible files are: vmlinuz vmlinuz
2.6.32.11pclos2

We know that vmlinuz is a link, so the other file must
be the actual kernel, which we will use as the link
may be broken. We don't have to type in the full
name, just add the hyphen and press tab to let grub
fill in the rest. This also avoids typing errors.
grub> kernel /boot/vmlinuz <tab>
grub> kernel /boot/vmlinuz2.6.32.11
pclos2
[LinuxbzImage, setup=0x3a00,
size=0x1f4400]
That seems to have worked so now we can do the
same for the initrd.
grub> /boot/init <tab>
grub> /boot/initrd
Possible files are: initrd2.6.32.11
pclos2.img initrd.img
grub> /boot/initrd <tab>
grub> initrd /boot/initrd2.6.32.11
pclos2.img
[Linuxinitrd @ 0x1f9a3000, 0x63c8e2
bytes]
Ok! grub has all the information it needs so now we
can try booting the system
grub> boot <enter>
All of the above grub session was taken from an
actual installation, so I know that it works.
The safest way to try our some of these techniques
is to practice on a virtual box installation. It is easy to
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set one up, and there is an excellent article on this in
the October 2008 issue of the magazine written by
parnote, the current editor. The article installs
windows, but the principles are the same for a
PCLinuxOS installation.

Screenshot
Screenshot Showcase
Showcase

Posted by Texstar, December 15, 2010, running KDE 4
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ms_meme's
ms_meme's Nook:
Nook: Let
Let It
It Snow
Snow
Oh the weather outside is frightful
But my 'puter is so delightful
And since l've no place to go
Let it snow let it snow let it snow

It doesn't show signs of stopping
With Gimp my pics I’m cropping
Now a song on you I'll bestow
Let it snow let it snow let it snow
Now you may think that I'm off tune
Just blame it on the snowy storm
But I really do like to croon
Jack Daniels will keep us all warm
I read all the forum replying
Of every gal and guying
And now that we’re all aglow
Let it snow let it snow let it snow

OGG

MP3

Now you may think that I'm off tune
Just blame it on the snowy storm
But I really do like to croon
As my desktop I transform
Now some of you that live down under
Will think I've made a blunder
You say the sun is fine
So let it shine let it shine let it shine
Forum friends live in hot and cold
At least that's what I'm told
But wherever you are from
To the Forum come come come
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Repo
Repo Spotlight:
Spotlight:

Radio
Radio Tray:
Tray: Music
Music To
To Your
Your Ears
Ears

by Paul Arnote (parnote)

We've all been there – working hard at the computer,
or just browsing the web, and we notice the dead
silence. Sure, we can play audio files in our favorite
audio player, but that means stopping every now
and again to load up another playlist. Sometimes, it's
nice to just sit back and have a steady stream of
music without any intervention from us, except
starting it. Or maybe you like to listen to your favorite
sports talk show, or your favorite talkradio
commentator. This is where a streaming radio
application comes in. In fact, maybe something like
Radio Tray.
Sure, there are other applications that play steaming
internet radio. But most of them do so with a lot of
overhead. Radio Tray does one thing, and does it as
unobtrusively and economically as can be expected.
That one thing is to bring streaming internet radio to
your Linux desktop.
Currently at version 0.6.1, this is the description from
the Radio Tray home page:
Radio Tray is an online radio streaming player that runs
on a Linux system tray. Its goal is to have the minimum
interface possible, making it very straightforward to use.
Radio Tray is not a full featured music player, there are
plenty of excellent music players already. However, there
was a need for a simple application with minimal
interface just to listen to online radios. And that's the sole
purpose of Radio Tray.

As Radio Tray continues to stream your selected
radio station, a pop up notification will appear with
each new selection that is played.

That Radio Tray has a minimal interface is an
understatement. When it's running, the only
indication is the icon that is placed in the system tray
of your panel. In the screen shot above, it's the
second icon from the left. A click of your left mouse
button displays the popup menu that allows you to
select from the radio stations you have programmed
in.

While it's playing, the "radio waves" of the Radio
Tray icon turns blue, and if you hover your mouse
over the icon, information about the currently
selected radio station and the selection playing is
displayed in a pop up tooltip. Also notice that next to
the radio station name is a volume setting. Scrolling
your mouse wheel over the Radio Tray icon will turn
up or turn down the volume of the audio stream,
independent of your main sound volume.

Setting Up Radio Tray
Of course, you will need to install Radio Tray from
the PCLinuxOS repository. Once installed, it will
appear under the Sound category in your PC menu.
Radio Tray is a small python program that uses a
variety of gstreamer plug ins to stream the radio
station to your desktop. There are also a variety of
gstreamer plug ins available in the PCLinuxOS
repository. For example, to play radio streams
whose address begins with mms:, you will need to
install the gstreamer mms plug in. Playback of AAC
streams will require installation of the gstreamerfaac
and gstreamerfaad plug ins. It may take a little trial
and error to find the right gstreamer plug in, but
you'll usually stumble upon it.
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A right click of your mouse button on the Radio Tray
icon will display the menu shown above. Selecting
"Configure Radios..." from the menu will bring up the
configuration dialog box.

One of the newest features of the most current
version of Radio Tray is the ability to group your
radio stations by genre. To start with, you will want to
define your genres. Don't worry if you don't get them
all in at first. You can add additional groups later.
You will, however, want to create your group entries
first. Once you have a station entered, you cannot
change or edit the group that station belongs to.

Click on the "Add Group" button to display the dialog
box shown above. You can assign your new group to
the "root" parent group, which will make your new
group entry appear as a top level menu entry. Or,

you can also assign your new group as a subgroup
of any other group entry you've previously made,
allowing you to have nested "levels" of submenus.

You can also sort your list by highlighting the item
you want to move and selecting the blue up or down
arrows until you have your groups in the order that
you wish.

Clicking on the "Add" button in the "Configure
Radios" dialog box will bring up the dialog box
shown above. Enter the name of the radio station on
the first line, and the URL of the radio station stream
on the second. Select the group you want the radio
station to appear in on the third line, and click
"Save." Repeat this for each radio station stream
you wish to add.

Selecting the "Move Group" button brings up the
dialog box shown above. This is handy if you want to
further refine your genre groups. Say, for example, I
wanted to move my "Beatles" group to become a
subgroup of "RockNRoll." I can move the "Beatles"
group to where "RockNRoll" is it's parent group,
and thus appearing as a submenu under the "Rock
NRoll" menu.

Finally, selecting "About" from the left click menu will
bring up the About Radio Tray dialog box.
Finding Streaming Radio Stations
Actually, it's not very hard to find streaming radio
stations. Probably the first place to check is the
Shoutcast radio directory. There, you will find over
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40,000 streaming radio stations from all over the
world. Many are internet only radio streams. You can
also check out nearly 6,000 additional radio streams
from the Icecast streaming directory.
You can also stream your local radio stations. The
best way to find them is to visit the web site of your
favorite local radio station, provided they have a web
site. If they do, chances are high that they a "Listen
Now" or "Listen Live" link. Pay attention to the
address that pops up in the playback window.
There's a chance that URL will also work with Radio
Tray. On other stations, they have links for other
devices (such as Blackberry devices and iPhones),
so if the "regular" stream won't work, there's a high
likelihood that one of the other links will work with
Radio Tray.

Screenshot
Screenshot Showcase
Showcase

You can also search on various forums that deal with
streaming audio enthusiasts, where you can obtain
difficult to find radio streaming URLs, many that the
originator of the broadcast might not want to be
widely known.
Conclusion
Radio Tray offers up countless hours of listening
enjoyment. It's small and unobtrusive. Most of all, its
fun and easy to use, without the overhead of many
of the other applications that also play streaming
audio feeds. You will undoubtedly find an audio
stream that suits your taste, and treat your ears to
audio streams most pleasing to you.

Posted by coffeetime, December 13, 2010, running Wmii
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E17:
E17: Settings
Settings Panel,
Panel, Part
Part 1
1
by Meemaw
In your newly installed E17 desktop, you will want to
tweak all your settings so it looks and acts just the
way you want it to. For that, you will need to open
the E17 Settings Panel. Since it has many sections,
we will investigate E17's Settings Panel in three
installments.
Left click your menu button (or anywhere on your
desktop) and choose Settings > Settings Panel.
The first window you see will be the main settings
window which opens the first section, Look, by
default.

As you can see, any appearancerelated item you
would want to change is located here. When you
click on any of the listed items, another window will
open and allow you to configure that item to your
liking.
The Look section is the longest and includes the
following sections:
Wallpaper  Here you can change the wallpaper on
your desktop. As covered in another article, you can
have each desktop display a different wallpaper, and
that can be done from the Screen section below.
Theme  Your theme can be changed here.
Colors  Colors on borders, backgrounds and fonts
can be altered.

changing to the X mouse cursor theme. (See
http://www.pclinuxos.com/forum/index.php/topic,763
17.0.html)
Transitions  You can assign 'crossfade' or 'vswipe'
to a few window transitions, or have no transition.
Scaling  Sets the DPI scaling for your monitor
display.
Startup  You can change the look of your startup
screen here.
Dropshadow  This configures the drop shadow
that appears on your windows. You can change the
location and size of the shadow.
The next section is Apps.

Fonts  You can assign different fonts to your
window designs (I don't know about you, but
sometimes I want something just a little different
from the font that's the default.)
Borders  Window borders can be altered here. Be
careful... if you decide on borderless, it may take
your window's title bar as well.
Icon Theme  Some of our artists make beautiful
icons! You can try them by changing the icon theme
here. You'll have to have them installed from
Synaptic, however.
Mouse Cursor  By default there are two cursor
themes, Enlightenment and X and you change it
here. Some people have noticed that the
Enlightenment cursor theme may cause a memory
drain on your system, which can be solved by
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New Applications  Suppose that you installed
something that wasn't in the repos (I know, they
frown on that but a few of us do it anyway.) If it
doesn't install a link in the menu, you can add it
using this section.
Favorite Applications  In the default menu, you
will see Favorite Applications. You can add your own
favorites to that menu here. The defaults are Firefox,
Configure Your Computer (PCC), and Synaptic.
IBar Applications  If you have an IBar, you can
also configure it here to contain the applications you
want
Restart Applications  There is no information
available (that we can find) describing what this item
is about.

Screensaver  Configure XScreensaver here.
Power Management  This is where you can set
hibernate or sleep. I always set my monitor to turn
off after two hours of nonuse. (I hope it saves some
power overnight!)
Window Display  Determines placement of
windows and display of window geometry
whenever windows are moved or resized.
Window Focus  How to activate windows.
Window List  Which windows have to be shown
in the windows list (e.g. in your task bar), and
some options for the behavior.
Window Geometry 
Settings for moving and
resizing of windows (like
resistance of edges, etc.).

The next section is Screen>

Window Stacking  How
windows are stacked, or if
windows may appear above
full screen windows, etc.

Screen Resolution  This is
where you change your screen
resolution.
Screen Lock  For privacy,
you can lock your screen if
need be.

We will continue next month.

The next section is Windows >

Startup Applications  If you
want Dropbox, XChat or Pidgin
to start on boot, you can add
them to Startup in this section.
Virtual Desktops  Another
place to configure your
desktops.

can set it to 'remember' where your application
window should open, and when you start the same
application again, it will appear in the same place,
with the same size.

Window Maximize Policy 
How windows have to be
extended when maximizing.
Window Remembers  Here
are the window size and
position coordinates that
Enlightenment remembers for
all different applications. You

Come
Join Us!
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Forum Foibles:
Foibles: PCLinuxOS
PCLinuxOS Weather
Weather Roundup
Roundup
Weather's a topic that everyone loves
That really is no surprise
Read here to find what's been said
Words of wisdom and so very wise

"In the meantime have a tequila or two"
Advises Crow making his Christmas punch
Everybody grabs beach towelssuntan lotionbeer
And heads to Linuxera's to have lunch

The Brrrrrr topic was started by Linuxera
"Jeepers Creepers! Who turned off the heat?"
MeeMaw shivered "It's supposed to drop to 15"
I think she was also getting sleet

"We will get that white stuff again"
smileeb says getting very weary
"BBBrrrr Thats Cold!!!" replies Wildman
"So much for the global warming theory"

bones113 observed "It is stayin' indoors weather"
joble moans "Oh man, it's getting colder"
We'd be warmer if we snuggled together
Instead of bolder the cold makes joble older

"We were in the upper 50s Saturday"
Padma says "Almost didn't need a jacket"
Then an arctic front came in
And his car started making a racket

Sammy2fish says minus 41 is the windchill
"Thank goodness for rye in the freezer."
"Getting a wee bit sunburned here in Texas"
ms_meme waves her fan....what teaser

Then GuypronoucedGuynotGuy
Being so true to his name
"That's what happens in Winterpeg, Manisnowba"
He knows how to play the game
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And so 2009 came and went
Everyone was shivering and sweating
What would the forecast bring?
No one was even betting

MGBguy yells "Batten down the hatches
Put on the wooly Pjs and huddle
Under the down quilts"
That should get us out of the muddle

2010 started out as usual
It was cold weather at a glimpse
Then sticktoo that daring young smarty
Called all us oldies "Wimps"

"There was some frost on my pumpkin"
Roc4Fun reports from Kansas City
"My mailbox is barely sticking out"
Says grnich looking for pity

Neal reports the snow is coming
And it is not going to abate
"Playing heck with my joints
That's not so great"

Archie muses "Come to think of it
Winter ain't done with my part of the pond"
"Times are a changin. Spring is springing"
Sammy2fish does respond

grnich announces "Great news,
Temps have shot up to a balmy 6
More snow is coming tonight"
Probably with ice and sleet to mix

longtom from South Africa
"We need urgently rain"
Sammy2fish replies
"Snow melting, water running to the drain"
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Sammy2fish loves to post about the weather
"The weather... just finished having some hail"
"Cold and I love it" says deathromantik from afar
"Too bad I have a cold as well"

Neal fried eggs on his sidewalk
To go with his coffee brew
parnote gave us a bit of hope
"There's a cool front moving through"

She_Devil shares great pictures
From her travels all over the west
"Tally ho!!! we hear her cry
As she looks for weather that's best

Yoyo likes summer temps
It's then he makes his hits
"Hot weather increase the probablity
of finding women in sexy outfits"

This urgent cry just in from Crow
"First hurricane about to hit my state"
"Batten down the hatches" warns Wildman
Good advice don't play with fate

"Thought I'd dig out me thong"
Scoundrel brags where he stood
longtom replies "I dunno
Some parts might look smaller than they should."

Summer started what a scorcher
No rain anywhere was found
"I don't care where it comes from
Cried Rudge "All my grass is brown"

Although it was hot and humid
From the forum came a cheer
ka9yhd announced "If you're having a BBQ
I'll bring the beer"
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Testimonial:
Testimonial: Paradise
Paradise
by Patrick Lowe (MountainMan)
Greetings from the Pocono Mountains.
What a long strange trip it's been. When I began
working in photofinishing, the computers controlling
high speed printers interfaced with a teletype, a
punched paper tape device was used for loading the
program and making backups. Commands were
three letters and my two finger typing style was well
suited. I still use those 2 fingers. (Mountain girl
sometimes gets impatient with it and pushes me
aside to type at 70 wpm, which makes me sick to
watch). My interest was aroused, so I took a
computer course at the local university. Using
punched cards, my tiny program filled an entire size
10 shoebox. I think that there must have been a lot
of trees sacrificed to computers back then. When 8
inch floppy discs came out, the teletype was
replaced with a monitor and keyboard. Then there
was a modem. By cradling the phone handset in 2
cups, sounds were sent through the speaker and
mike, and it would communicate with a computer in
another state! (wee bit slower than my current 15
Meg cable service, a perk of mountain girl's job).
Life happened. Fast forward to 1999 and the Internet
seemed to be as essential as indoor plumbing. I
bought a PC to get on the web. (Duh, I couldn't do it
with the refrigerator right?). Several years of MS,
and the boredom and disappointment was more
than I could bear. Building a faster computer didn't
satisfy me, so I searched the net and found Linux.
You know which one. The kids would say the name
and laugh  how can you take that seriously Dad? It
became a love/hate thing  loved the freedom to
change things, and hated that I had to. Kept trying

so many "new releases" of distros, and then
spending so much time trying to update them and
make things work the way I wanted. At some point
in my explorations, I used an abandoned KDE 3.5
that was much to my liking. So I went about testing
KDE distros and, sadly, they were early version 4.x.
Most of them gave me the feeling of wanting to fist
my keyboard after 20 minutes.
PCLinuxOS caught my attention through a review.
With the usual promise of nirvana, and the usual
expectation of letdown, I tried it. A little bumpy at first

go on my test box with Intel graphics, but it was
workable, so I installed. I then installed on my main
box, and it was like entering the twilight zone. It was
paradise. Everything I wanted worked. KDE, and
most everything else, was uptodate. No bouncing
cursor pets, no pop up messages in a foreign

language, and it was fast. I felt my quest was at an
end. In this paradise, I have thought a couple of
times that I want something different. Then, I either
find it on the forum, in Synaptic, or it just appears in
an update, almost as if Tex is my personal genie.
I am a casual user. By that, I mean I really don't
have time or knowledge to dig into things. For two
months now, things have been great. The other shoe
didn't fall. No big problems that I couldn't solve by
searching through the forum. I began learning things
here that were useful, because the questions had
been asked, and knowledgeable people took the
time to give a meaningful answer. I had read it
before. This is the best forum (and that is no bull).
Whenever I get on line, I take some time to sniff
around the forum or read the magazine. I installed
Enlightenment on a partition, and WOW, I just kept
opening and closing Firefox and a few other things
and giggling. (Eat your heart out, Puppy). When
mountain girl saw the wood theme by Agust she
said, "That's nice. I like that." (I want the Grunge
theme  hello? genie?). Her comment is meaningful
because in the 3 years of using Linux, the only thing
I have heard from her is "Why do you spend so
much time messing with the computers? Can't we
just use Windows? The walls need to be painted."
She uses Windows every day. But she also uses my
computer at the same time for Pandora and all that
social stuff.
The Windows fans here so far are very impressed.
No problem riding without a panel or dock.
Everything I want is within a click on the desktop. It
is often said that if Linux looks like Windows, those
fans will use it. I think when it is fast, beautiful,
functional, easy to learn, and better, then you have
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their interest. PCLinuxOS Enlightenment is all that.
I'm on the edge of my seat for the final release.
Maybe nirvana doesn't exist. I will settle for
Enlightenment. There is one really strange thing on
the menu "Run Everything"  HOLY MACKEREL 
really? Shouldn't there be a footnote, something like
"in the event of invasion?"

Screenshot
Screenshot Showcase
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I'm beginning to think that my KDE partition is going
to be collecting dust just like the Windows one is.
Before PCLinuxOS, I would not be comfortable
recommending Linux to friends.(Well, if I had
friends). It's pretty much a geeky thing to people that
aren't quite sure what tabbed browsing means. Also,
I have never registered for a forum nor made a
donation. PCLinuxOS inspired both. This testimonial
has gotten pretty long, and at this point there would
be some saying, "Gosh, I wish he had just sent the
money." I'm not sure it gets said enough, but I
wanted to say thanks to Tex for creating this
paradise, and thanks for a great community.
Peace
Pat

Want to keep up on the latest that's
going on with PCLinuxOS?

Posted by kensum71, December 29, 2010, running e17

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos
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Wbar:
Wbar: A
A Mac
Mac OS-X
OS-X Like
Like Quick
Quick Launch
Launch Bar
Bar
by Daniel MeißWilhelm (Leiche)
Wbar is an animated quick launch bar for Linux,
similar to the one in Mac OS. The zooming launch
bar provides nice eyecandy and transparency, even
on lowend graphic cards and without the need of
Compiz, making it suitable even for older
hardware/computers. Below is a screenshot of
Wbar:

Here, the option pos top will place the Wbar at the
top of the desktop. It is a good idea to use this
option because without it the Wbar will be placed at
the default location, the bottom of the desktop,
where it may be hidden under the default KDE
panel. Additional options of wbar are shown in the
screen shot at the bottom of the previous column. To
view the other options on your computer, type wbar
help on the command line.
Further details details on Wbar options will be
described later when introducing the WbarConf.

How do I get Wbar and how do I use it?
Wbar can be installed from Synaptic and then be
started via either Start → System → Monitoring →
Wbar or from the command line using:
/usr/bin/wbar pos top abovedesk

How do I start Wbar automatically upon login?
Start Konqueror via the desktop shortcut Home.
Select View – Show Hidden Files from the
Konqueror menu, browse to the folder
.kde/Autostart, and create a new textfile named
startapps. Open this file with the text editor of your
choice and insert the following two lines:
#! /bin/sh
/usr/bin/wbar pos top abovedesk &
then save this file and close the text editor. Finally,
we need to make this file executable. Rightclick the
file, select 'Properties' and in the new window, click
the tab 'Permissions' and set a tick mark next to 'is
executable.' The Wbar will now start automatically
upon each session startup. By the way, if you wish to
start more applications upon startup, simply add
their commands at the end of this file. For example,
to autostart Firefox, you would add the line
firefox &.

WbarConf
Note: WbarConf is not available in the official
repositories and hence, its installation and use is
at your own risk.
WbarConf is a graphical user interface (GUI) to edit
and customize Wbar. Download the latest version of
wbarconf (at the time of writing wbarconf
0.7.2.tar.gz) and unpack it (rightclick, Extract →
Extract Here). Now open a rootterminal via:
Start → System → Terminals → Terminal
Program  Super User Mode
and insert your rootpassword. The current working
directory of the rootterminal is /root, and we need to
change to the directory wbarconf extracted earlier.
An easy way to do this is to position your mouse
onto this directory in Konqueror, then drag and drop
this icon onto the rootterminal, and select 'cd' from
the appearing droplist menu. You could now enter
pwd to confirm being in the extracted directory
wbarconf. To install WbarConf, simply enter the
command:
./install.sh /usr/
in the rootterminal. You can now close the root
terminal, open the standard KDE terminal, Konsole,
via:
Start → System → Terminals → Konsole 
Terminal Program
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and start wbarconf from the Konsole using the
command:
wbarconf &
which will bring up the following window:

This will save the Wbarconfiguration in the user's
homefolder as a hidden file named .wbar. Selecting
File → Settings in the WbarConf window will open a
new window, where you can customize the
appearance of Wbar:
From the list of applications in the left panel, you can
see the roots of Wbar as a GTK application, but of
course you can now add/remove any application you
require for your personal needs. But first we want to
add WbarConf so we can start it easily from the
Wbar quick launch bar, instead of the command line.
Clicking the 'Add' button will open a new entry in the
left panel, and after inserting a title, the command,
and browsing to the WbarConf icon in the extracted
folder, we finish the new entry by clicking the 'Save'
button:

Do not forget to activate and mark the 'Position on
the screen'entry to be at the top of the screen to
avoid the Wbar being hidden under the default KDE
panel at the bottom of the desktop. Here, you can
also modify the Zoom and the Jump factor to your
liking. Clicking the 'Refresh'button will immediately
apply the new settings without the need of restarting
the WbarConfGUI or Wbar itself. Finally, close the
'Settings'window and press 'Save' and then 'Close'
in the WbarConf window. WbarConf is a user
friendly GUI to customize the settings and
appearance of Wbar. Alternatively, and if you know
your way around, you could use your favorite text
editor, open the Wbar configuration file .wbar and
add/remove/edit your customized settings or any
applicationspecific ict linetriplet (icon, command,
title) after the initial 6 lines:

Wbar is similar to the iBar in gOS. So, now have fun
with Wbar and WbarConf!
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Languages From
From A
A to
to Z:
Z: Unicon
Unicon
by Gary L. Ratliff Sr. (eronstuc)
In the March 2010 issue of this magazine, we
covered the language Icon and mentioned then that
there were some extensions which gave support to
OOP and other features. This article will center upon
the language Unicon, which was developed by Clint
Jeffery. The name Unicon stands for: Unified
Extended Dialect of Icon.
I asked Dr. Jeffery two questions: Why did you
develop the language Unicon? And, did you work
with Dr. Griswold (the developer of Icon) in the
creation of the language? On August 10, of 2010 I
received this reply from him in answer to these
questions:
Unicon was created because we loved Icon
and wanted to be able to use it in large, IO
rich complex modern software systems. “We”
started out as Shamin Mohammed and
myself, and has included many users,
students and internet volunteers over the past
decade.
To improve scalability to large programs we
made various improvements to the internals
of the VM, along with adding classes and
packages. We also dramatically improved the
scalability of its optimizing compiler, iconc.
More recently we are in the process of adding
concurrency and improving the interface for
calling native (C language) code. To improve
IO capabilities, we have added very high level
networking, database, and graphics.
I discussed many of our plans with Ralph
Griswold, the inventor of Icon, who was my

Ph. D advisor. While he was not inclined to write the
larger programs that motivate the use of classes and
packages, he supported some of their early
experimental development. Ralph also supported
the first major component of the IO extensions, the
2D graphics that made it into Icon versions 8 and 9.
He froze the Icon language prior to his death, and
asked us not to call our successor Icon2, which he
felt sounded too close to Icon, but gave his blessing
to the name Unicon.

This is a 470 page document, and it offers a
thorough introduction to the features of the
language. It moves systematically through the
features and has full coverage of the language and
the Icon libraries in the many appendices in the back
of the book.

Learning the Unicon Language

The following are some examples of the treatment
offered by the language to some of the new
concepts which this language introduces, which
extend the features offered by Icon:

The best approach to learning the features and
syntax of Unicon would be to read the Unicon book
which is mentioned on the home page of the Unicon
language: http://unicon.sourceforge.net/book/ub.pdf.

The book also serves as an introduction to the
concepts of software engineering, as well as the use
of OOP in developing large software systems.

Here are examples of the 3D primitives offered by
the language. In the previous Icon article, we
presented some examples of the use of 2D
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graphics, which the language Icon provides. It is
highly recommended to become very familiar with
the Icon treatment of graphics as covered by the
book "Graphics Programming in Icon." Alas, this
doesn't seem to be available as a download from the
web, but is available from Amazon for a low rate.

Obtaining Unicon
From the home page of the Unicon language, you
will find an area called Unicon Downloads. There is
a listing for several operating systems. Now I was
able to successfully install the system for my
Windows partition, which uses the Windows
XP Media Center Edition. This will allow the
user to develop and test Unicon programs
using an environment available from running
ui.exe.
When I followed these instructions for
developing a system from source code
following these instructions from the
README file:

1. Download the file, which will be a zip file.
2. Unzip the file
3. make Configure intellinux
4. make Unicon
The steps through item 3 completed successfully. At
step 3, you will be instructed to make the Unicon/bin
directory part of the path. Then, on step 4 there were
two errors reported. Despite this fact, the unzipping
will obtain a complete set of Icon programs which
are usable, if you followed the instructions for
installing a useful Icon system to your PCLinuxOS
system. The text covers the Icon program fully in
one of the appendixes. You will need to have a
functional Windows system so that you may fully
explore the features of the Unicon system via that
route.
Dr. Jeffery mentioned that he could help users if they
were having problems installing the system. As I
failed to write any articles during the mourning
period after my wife passed away, I no longer have a
lead time of close to a year. So I will leave getting
this as an exercise for the reader.

The authors of the Unicon text recommend that in
order to develop large software systems, one
master the language UML. The text presents
several examples of this in the development of
programs and recommends the book "The Unified
Modeling Language User Guide," by Grady Booch,
James Rumbaugh, and Ivar Jacobson, which I
found was available as a free pdf download >

After reading the text fully, the Unicon language was
found to be an intriguing language and my
explorations of the system, albeit conducted from
Windows, revealed that the system worked as
advertised in the text.

When downloaded, it will be named Addison
Wesley.pdf, and appears in your download
directory within in your home directory.
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Reach Us On The Web
PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine
PCLinuxOS Magazine Web Site:
http://pclosmag.com/
PCLinuxOS Magazine Forums:
PCLinuxOS Magazine Forum:
http://pclosmag.com/forum/index.php
Main PCLinuxOS Forum:
http://www.pclinuxos.com/forum/index.php?board=34.0
MyPCLinuxOS Forum:
http://mypclinuxos.com/forum/index.php?board=157.0

Posted by rob0917, December 19, 2010, running LXDE

44

Testimonial:
Testimonial: Hello,
Hello, From
From St.
St. Louis!
Louis!
by Fred McKinney (fredbird67)
First of all, many many thanks to Texstar and the
gang for creating such a fine distribution.
My name's Fred, and I'm living in Ballwin, Missouri,
which is one of MANY suburbs of St. Louis. I was a
WinD'OH's user for over 10 years, until switching to
Linux on my computer in January of 2005. I haven't
looked back since, with my first distro being
Mandrake 10.1. Believe it or not, I'm a returning
PCLinuxOS user. I had tried PCLinuxOS once in
2006 and had a little problem with the monitor I had
at the time. I didn't have a clue how to fix it. So I
went with Mepis instead. Mepis worked great,
although I didn't care for some of its default settings
in KDE.
One evening during the summer of 2007, out of
curiosity, I was wondering what else was out there in
distroland. I had seen that PCLinuxOS had come
out with the 2007 version a few months before, so I
tried it. Honestly, I liked it a lot better than Mepis, so I
went with PCLinuxOS 2007 in August, especially
since I had missed some of the eyecandy that
Mandrake offered. I loved that "Galaxy 2" KWin
decoration that Mandrake used as the default at the
time I was using it, and was happy to see that it was
available in the PCLinuxOS repos.
Everything was going great, until I learned that KDE
was coming out with version 4. I had seen some bad
reviews of it, but I thought I'd give it a chance. In
early 2008, I downloaded a Live CD of SuSE with
KDE4. It was unstable, slow, and I felt LOST in the

thing. I felt that if KDE was gonna throw the perfectly
good version 3.5.x away for that piece of crap, then
why bother staying? I reluctantly got rid of
PCLinuxOS 2007 in favor of Ubuntu and Gnome,
later switching to Mint. However, at the time, I had
no idea that Texstar was planning to stay with KDE
3.5.10 for the desktop. Yet, I felt that if KDE was
going to dump it for the piece of crap that KDE 4
turned out to be, at least when it first came out, I
wanted no part of it at all.

This past spring, I switched desktop environments
again to Xfce when I learned that Gnome was going
to do a major overhaul in the form of Gnome 3.
Remembering what I had gone through with KDE, I
did NOT want to go through that again. Also, I had
noticed several people on GnomeLook who were
outright hateful and rude, and I'd had enough of their
attitudes. That too played a part in my switch from
Gnome to Xfce, even though I can comfortably run
Gnome and maybe the current KDE on my system.
Eventually, Ubuntu's and Mint's policies of coming
out with a new release every six months got on my
nerves (backing things up, doing a clean installation,
etc.). Especially considering that Ubuntu has never
been a rollingrelease distro, which would very much
be appreciated if they're gonna release new versions
that frequently.

Some 6 months later or so, I had heard that there
was a GNOME version of PCLinuxOS available,
which naturally got my attention. I tried it once, but
never could get the printer I had at the time to install
on there, so I gave up on it and went back to
Ubuntu.

I had also discovered that earlier this year,
PCLinuxOS came out in nine different versions in
addition to KDE and GNOME, such as Xfce,
Openbox, LXDE, and Enlightenment. Plus, since I
had seen that PCLinuxOS is a rollingrelease distro,
I had to try it. I tried it once, a month or two ago, and
was really liking it until I found that a GTK theme I
like wasn't displaying properly on it, and no one else
had mentioned the problem I had found. I went back
to Mint for a while, but the urge for a rollingrelease
distro was still there like an itch that wouldn't go
away, so I downloaded Phoenix (the Xfce edition).
I had tried the latest Crunchbang, which wasn't bad,
but I never could get Compiz to work on it. I then
gave PCLinuxOS another try when I learned that the
theme I had a problem with, (one of the ShikiColors
series of themes), also came in a Clearlooks
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version, in addition to the Murrine version. I thought
"OK, I could live with that". It turns out that the
Murrine version from GNOMELook worked
perfectly. I had used the ShikiColors themes in the
repos earlier, so I thought I'd explore things further.
The other night I was trying to set up the printer I
have connected to my PCLinuxOS box, and boy was
I having a hard time getting it properly set up to print
from my wife's laptop. The advice I had gotten from
the forum wasn't all that helpful and I came THIS
CLOSE to giving up and going to Xubuntu. But I
then tried having PrinterDrake detect and install it 
and from there, I got it to print perfectly from both
computers! Turns out that I made the mistake of
installing it from CUPS, which made it a pain to get
networked printing working just right. But
PrinterDrake made it much easier to accomplish, so
I was happy.
I then set up Compiz, which I was able to do in
about 5 minutes. And I must say that whenever I
have the Emerald Theme Manager open, on Ubuntu
or Mint, it would periodically gray out and become
unresponsive. But I haven't seen that at all with
PCLinuxOS  it's ready to do whatever else I want
and, so far, it has stayed completely responsive at
all times. I've still got a lot more to do in getting
everything set up and getting my backedup files on
their new home on PCLinuxOS. But once I do, I'm
planning on also putting it on a spare desktop we
have.
And then, I'm planning to install PCLinuxOS Phoenix
on a flash drive I carry around with me all the time. It
currently has PC/OS (no relation to PCLinuxOS) on
it, which is one of only a handful of distros I've tried

that properly detects the Broadcom wireless card on
my wife's Dell Inspiron 6000 laptop. The reason I've
been wanting to get rid of PC/OS is because of their
plans to charge for the next version. But, thankfully,
I've found that PCLinuxOS also properly detects that
Broadcom card, too. Plus, I love how you can create
a USB drive of PCLinuxOS with whatever programs
you have installed at the time you create it too. So
that will be so cool to be able to take ALL my favorite
Linux programs with me in my pocket!
In closing, (did you think I'd ever get here? LOL), I
must say that I'm quite pleased to see PCLinuxOS
available with multiple desktops, that it's a rolling
release distro, that it has some very advanced
capabilities for creating a live USB, and that it
detects Broadcom's wireless cards. Ubuntu may get
the most publicity, but as far as I'm concerned,
PCLinuxOS sets THE standard by which all other
distros are judged.

Want
Want To
To Help?
Help?

Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.
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ms_meme's
ms_meme's Nook:
Nook: From
From This
This Moment
Moment
From this moment on P C L
You're for us you are the best
From this moment on

O

S

From this happy day no more distro hoppin'
We found you so we're a stoppin'
From this moment on

OGG

MP3

For you've got the desktops we love so much
You never leave us in a clutch
Got a forum where we can play
See our friends there everyday
From this moment on we give thanks to Tex
PCLOS is never complex
Every care is gone
From this moment on
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More
More Screenshot
Screenshot Showcase
Showcase
Top Left: Posted by
bones113, December 5,
2010, running KDE 4.
Top Right: Posted by
chilly, December 9,
2010, running KDE 4.
Bottom Left: Posted by
coffeetime, December
27, 2010, running
OpenBox.
Bottom Right: Posted by
bingyman, December
21, 2010, running
KDE 4.
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